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 What's New

The following topics describe the new features in this version of the Staff

Assignment. See the Vocera Server Release Notes for a complete list of changes

for this version.

This release includes the following new features and enhancements:

Active Directory Sign On

Users now have the option to login to Staff Assignment using Active Directory

credentials. This option must be configured by the system administrator.

Windows 2012 Support

The Vocera Server is now supported on the Windows 2012 platform. On

Windows 2012, you must use "Run as administrator" to start the Vocera Server

and to edit any text files that the server uses. For best results, use the Services

window to start the Vocera Server.
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 Introduction

Staff Assignment is a Web application hosted on the Vocera Server. It allows

you to quickly assign staff members to Vocera groups, which can be role-based

or they can represent a coverage area, such as a hospital room or bed. For

example, you can use Staff Assignment to assign nurses to beds for different

hospital units during a shift.

Hospital staff assignments are typically made by a charge nurse, unit secretary,

or ward clerk. These assignments can be made based on location or expertise,

or for continuity purposes.

Using the Staff Assignment application to assign nurses is more efficient than

using Vocera commands to add nurses to bed groups. It allows you to

• Ensure that every bed has proper coverage

• Ensure that Vocera call flows work properly based on assignments

• Print a report of bed assignments

About This Guide

This guide is intended for anyone using Staff Assignment to assign hospital staff

members to patient beds. It is also intended for Vocera system administrators

who need to set up the application.

Browser Requirements

To access Vocera Voice Web applications (Administration Console, User

Console, Report Console, and Staff Assignment), your computer must have the

following required software:



 Browser Security Requirements

8 ··· Staff Assignment Guide

Table 1. Web application software requirements

Applications Client-side component Requirement

All applications Browser Internet Explorer version 7, 8, or 9. Internet
Explorer versions 10 and 11 are supported in
compatibility mode.

Administration Console

Report Console

Java Runtime Environment
(JRE)

JRE 6.0 (1.6) from www.java.com

Important: Do not install another JRE on the Vocera Server or Vocera Report

Server machines. The required version of Java is installed with those servers.

Browser Security Requirements

Configure the following Internet Explorer security settings:

• Configure the Internet Explorer security level to Medium-low or

lower – Otherwise, Internet Explorer prevents the scripts used by the

consoles from executing completely. You can configure security settings

through Tools > Internet Options > Security in Internet Explorer. See your

Internet Explorer documentation for complete information.

• Disable the pop-up blocker – Vocera consoles display information in

pop-up windows, so disable pop-up blocking in Internet Explorer (that is,

configure the browser to allow pop-up windows). Choose Tools > Internet

Options > Privacy, and then uncheck the Turn On Pop-Up Blocker box.

If you are using a third-party tool to block pop-ups, refer to the tool’s

documentation.

• Remove scroll bars from pop-up windows – Pop-up windows may display

scroll bars. To remove the scroll bars, choose Tools > Internet Options >

Security, and select the Local Intranet zone. Click Custom Level to display

the Security Settings dialog box. Enable Allow script-initiated windows

without size or position constraints.

• If necessary, add the Vocera Server and Vocera Report Server IP

addresses to the list of Trusted Sites – The security policy in certain

situations may prevent you from setting the Internet Explorer security level

for the local intranet below Medium. If Internet Explorer continues to display

pop-up windows with scroll bars, follow these steps to configure a trusted

site for the Vocera Server:
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To add the Vocera Server and Vocera Report Server to the list of

trusted sites:

1. In Internet Explorer, choose Tools > Internet Options. The Internet

Options dialog box appears.

2. Click the Security tab.

3. Click Trusted Sites.

4. In the Security Level for this Zone box, set the security level to

Medium-low, and click Apply.

5. Click the Sites button. The Trusted Sites dialog box appears.

6. Type the IP address of the Vocera Server, and click Add.

7. Type the IP address of the Vocera Report Server, and click Add.

8. Click Close to close the Trusted Sites dialog box.

9. Click OK to close the Internet Options dialog box.

A system administrator can manage the Internet Explorer Trusted Sites for

an entire organization using Group Policy Objects (GPOs). See the following

Microsoft article for more information:

• How to Configure Internet Explorer Security Zone Sites Using Group

Polices
1

• Do not access a Vocera Voice Web application from the server on

which it is running – By default, Windows Server 2003 and Windows

Server 2008 ship with Internet Explorer Enhanced Security Configuration

enabled, which may display frequent security prompts when you access

a Web application from the server on which it is running. Rather than

disable Internet Explorer Enhanced Security Configuration on the server,

we recommend that you access Vocera Voice Web applications from your

desktop or laptop computer.

• If your Vocera Server or Vocera Report Server has enabled SSL,

configure Internet Explorer to NOT save encrypted pages to disk – If

you enable SSL on the Vocera Server or Vocera Report Server, you may need

to update the browser security settings for Internet Explorer to make sure the

browser does not save encrypted pages to disk. Otherwise, certain pages of

the Administration Console, such as the Permission Browser, will not work

properly.

1
 http://blogs.msdn.com/b/askie/archive/2012/06/05/how-to-configure-internet-explorer-security-zone-sites-using-group-

polices.aspx

http://blogs.msdn.com/b/askie/archive/2012/06/05/how-to-configure-internet-explorer-security-zone-sites-using-group-polices.aspx
http://blogs.msdn.com/b/askie/archive/2012/06/05/how-to-configure-internet-explorer-security-zone-sites-using-group-polices.aspx
http://blogs.msdn.com/b/askie/archive/2012/06/05/how-to-configure-internet-explorer-security-zone-sites-using-group-polices.aspx
http://blogs.msdn.com/b/askie/archive/2012/06/05/how-to-configure-internet-explorer-security-zone-sites-using-group-polices.aspx
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To update Internet Explorer security settings for SSL access:

1. In Internet Explorer, choose Tools > Internet Options > Advanced.

2. Make sure the Do not save encrypted pages to disk option is checked.

3. Click OK.
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 Using Staff Assignment

This section describes how to use Staff Assignment.

Logging In and Out

You can run Staff Assignment within the Internet Explorer browser on any

Windows-based computer on the network.

By default, only Vocera users with System Administration permission can log

into Staff Assignment. A Vocera system administrator is responsible for setting

up the application to allow other users to access Staff Assignment. If you do not

have System Administration permission, ask the Vocera system administrator for

your Staff Assignment user name and password.

To use Staff Assignment Premier features, you must log into Staff Assignment

with your Vocera user ID and password or your Active Directory credentials.

Note:  Before using Staff Assignment, make sure the Internet Explorer

security level is set to Medium-low or lower. See Browser Security

Requirements on page 8.

To log into Staff Assignment using Vocera credentials:

1. Open an Internet Explorer browser window.

2. Enter the following URL:

Table 2. Staff Assignment URLs

Type of Access URL

Unencrypted http://vocera_ip_address/staffassignment

SSL https://vocera_ip_address/staffassignment

where vocera_ip_address is the numeric IP address of the Vocera server.

The Staff Assignment login page appears.
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3. Enter your Staff Assignment user name and password.

Note: If you don't know your Staff Assignment user name and password,

check with your Vocera system administrator.

• If you have a Vocera ID and have System Administrator permission to

Vocera, enter your Vocera ID and password to log in.

Note: You can also use Active Directory credentials to login.

For more details see, Logging In Using Active Directory

Authentication on page 12.

4. Click Login.

After you are connected, the Staff Assignment page opens.

To log out:

• Click the Log Me Out link at the upper right part of the page.

Logging In Using Active Directory Authentication

If Active Directory authentication is enabled, Staff Assignment users must sign

on using Active Directory credentials and select the Active Directory domain.

Note:  If Active Directory authentication in enabled, you cannot log in using

other system credentials. If you are unable to log in, contact your Vocera system

administrator.

Do not manage authentication type using the security options when Active

Directory authentication is configured. For details about configuring Active

Directory, see the Vocera Administration Guide.

To log into Staff Assignment using Active Directory credentials:

1. Open an Internet Explorer browser window.

2. Enter the following URL:

Table 3. Staff Assignment URLs

Type of Access URL

Unencrypted http://vocera_ip_address/staffassignment

SSL https://vocera_ip_address/staffassignment

where vocera_ip_address is the numeric IP address of the Vocera server.

The Staff Assignment login page appears.
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3. Specify the following values:

Field Description

User Name Enter your Active Directory user ID (up to 249 characters).

Password Enter your Active Directory password (up to 127
characters).

Active Directory Select the name of your Active Directory from the list.

If there are multiple Active Directories listed and
you're unsure which one to select, ask your system
administrator.

4. If your deployment hosts more than one domain, select your domain from

the list.

5. Click Login.

After you are connected, the Staff Assignment page opens.

Connecting to a Vocera Cluster

If you have a Vocera Cluster, the vocera_ip_address that you use to log into

Staff Assignment can be the IP address of any one of the servers in the Vocera

Cluster. The Staff Assignment application automatically connects to the active

node.

If you try to connect to a Vocera Server node that is currently in standby mode,

the application automatically redirects the browser to the active Vocera Server.

You can then log into the application.



 Assigning Staff Members or Groups to Units

14 ··· Staff Assignment Guide

Best Practice:  If your Vocera Server is clustered, bookmark the Staff

Assignment URL for each cluster node so that you can connect to Staff

Assignment in the event that one of the servers is currently down or is in the

process of being restarted.

Assigning Staff Members or Groups to Units

The Staff tab allows you to assign staff members and groups to each hospital

unit. Before you assign staff members to patient beds, you should make sure

that the correct list of available staff members has been assigned to the hospital

units. The charge nurse or ward clerk may assign staff members to units.

Note: By default, the Staff tab is visible only to Administrators.

Nurses and other staff members can float from site to site. Accordingly, you may

need to assign a staff member to a unit from a different site. If so, use the Find

Staff field to find a staff member at another site.

Note:  Up to 200 staff members or groups can be assigned to each unit. When

you assign a group to a unit, only direct members of the group are assigned;

members of nested groups are NOT assigned, primarily for performance

reasons.

To assign staff members or groups to units:

1. On the Staff tab, select a site from the Site list.

Note:  By default, your home site is automatically selected unless you

logged in as an administrator.

2. Select a unit from the Unit list.

3. To add staff members or groups to the unit:

a. Select one or more staff members or groups in the Staff and Groups

in Site list. Group names display in all capital letters to distinguish them

from individual staff members.

To select contiguous staff members or groups in the list, press Shift

+click.

To select noncontiguous staff members or groups in the list, press Ctrl

+click.

To find a user or group in the site, start typing a user's last name or a

group name in the find text box. A drop-down list appears with up to

10 matching users or groups. Select one from the list.
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If it is a long list, use navigation controls below the list to see the next or

previous 200 members.

b. Click the  button to move staff members or groups selected in the

Staff and Groups in Site list to the Assigned To Unit list.

4. To remove staff members or groups from the unit:

a. Select one or more staff members or groups in the Assigned To Unit

list.

b. Click the  button to move staff members or groups selected in the

Assigned To Unit list to the Staff and Groups In Site list.

To find a staff member in all sites:

1. On the Staff tab, select a site from the Site list.

2. Select a unit from the Unit list.

3. In the Find Staff field, start typing the last name of a staff member. A drop-

down list of up to 10 matching names appears.

4. Select a staff member from the list.

5. If the Add To Unit dialog box appears, click Yes to add the staff member to

the unit. Otherwise, click No.

If the Found In Unit dialog box appears, click Yes to remove the staff

member from the unit but not from any beds contained in the unit.

Otherwise, click No.

Assigning Staff Members to Beds

The Assignments tab allows you to assign up to eight staff members to each

bed or role in a hospital unit, although your system may be configured to

allow fewer than eight assignments. The list of staff members you can assign

is defined by the unit. If you cannot find a person in the list, you can also use

the Find Staff field to find any staff member. If a staff member that you find is

currently not assigned to the unit, you can choose to add him or her.

Nurses are typically assigned to multiple beds. However, you cannot assign one

staff member multiple times to the same bed.

Note:  In the Vocera Administration Console, the system administrator or group

manager can assign more than eight staff members (users) to a bed (group).

To assign staff members to a bed:

1. On the Assignments tab, select a site from the Site list.
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2. Select a unit from the Unit list.

3. Select one of the staff member cells for a bed.

4. Select a staff member using one of the following methods:

• Start typing the last name of a staff member. A drop-down list appears

with up to 10 matching names. If the staff member you are looking for

does not appear in the list of 10 matches, refine your search by typing

additional characters of the last name. Select a staff member from the

list.

• Double-click the cell or press Ctrl+U. The Available In Unit dialog box

appears. Select a name from the list and click OK.

• Copy and paste the assignment from one cell to another.

5. Optionally, enter notes (up to 500 characters) about the patient in the

Notes cell.

To copy and paste assignments:

1. Select a cell where a staff assignment has already been made for a bed or

role.

2. Right-click the cell, and choose Copy.

-or

Select the cell, and press Ctrl+C.

3. Right-click another cell, and choose Paste Name.

-or

Select another cell, and press Ctrl+V.

To find a staff member in all sites:

1. On the Assignments tab, select a site from the Site list.

2. Select a unit from the Unit list.

3. Make sure the Lock checkbox is unchecked. Otherwise, the Find Staff box

is not visible.

4. In the Find Staff box, start typing the last name of a staff member. A drop-

down list appears with up to 10 matching names.

5. Select a staff member from the list.

6. If the Add To Unit dialog box appears, click Yes to add the staff member to

the unit and the current cell. Otherwise, click No.
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If the Found In Unit dialog box appears, click Yes to remove the staff

member from the unit, or click No to keep the staff member. If you click

Yes, the Add to Unit dialog appears asking whether you want to add the

member to the cell or not.

Tips for Using the Assignments Tab

Follow these guidelines when working on the Assignments tab:

• Navigate using the arrow keys, Tab key, or Enter key, or click a cell to select it.

• Enter a staff member in one of the staff member columns by starting to enter

their last name.

• You must assign staff members to a bed or role from left to right, from 1st

Member to 8th Member. The previous staff member columns for a bed

or role must all have assignments before you can make an assignment in

the current column. For example, you cannot assign a staff member to the

8th Member column until staff members have been assigned to the 1st

Member through 7th Member columns.

• If you delete a staff member for a bed, the staff member in the next column

automatically moves one cell to the left to replace the staff member you

deleted.

• You cannot select duplicate staff members for a bed.

• To search for a staff member, begin typing a name in one of the staff member

cells. A drop-down list of up to 10 matching names appears. For example, to

display all available staff members whose last name begins with "Be", type

be in the cell.

To select a staff member from the drop-down list, move the mouse over the

name and then press Enter or click the name.

• Only valid Vocera user names can be entered or selected in the staff member

cells. If you enter anything else in those cells, the value will not be saved.

• To select a staff member from a list of all of the available staff for the unit,

double-click the cell or press Ctrl+U. The Available In Unit dialog box appears.

• Use the Find Staff field to find staff members at all sites.

• If you select a staff member who is already assigned to the unit, the Found

In Unit dialog box appears. Click Yes to remove the staff member from the

unit. Otherwise, click No.

• If you select a staff member who is not yet assigned to the unit, the Add

To Unit dialog box appears. Click Yes to add the staff member to the unit.

Otherwise, click No.
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• To delete an assignment, select the cell and press the Delete key.

• The Notes cell provides a place to write a brief note about the patient, for

example:

• DNR

• Clear Liquid Diet

• No visitors

• Maintain Reverse Isolation

• NPO

• Patient had a sitter

• Bilateral soft wrist restraints

• To save changes to a cell, press Enter or click another cell. The staff

assignment is saved to the Vocera Server.

• The status bar at the bottom of the Assignments tab indicates when

changes are saved.

Printing Staff Assignments

To print the complete staff assignments table, use the Print link in the Staff

Assignment application. DO NOT use the Print toolbar button in Internet

Explorer, or the File > Print command, because those print options print the

visible tab instead of the entire scrollable table.

To print staff assignments from Staff Assignment:

1. Click the Print link at the upper right part of the page.

A separate browser window opens with the complete assignments table,

and the Print command is invoked, which opens the Print dialog box.

2. Select print options, and then click Print.

Refreshing the Application with Data from the Vocera Server

By default, Staff Assignment refreshes the application with data from the

Vocera Server every 10 minutes. You can change the refresh interval if you

would like to refresh less or more frequently. When you refresh the data, the

application fetches new users that have been added to groups, any assignments

of staff to groups (including those made using voice commands) or assignments

that have been removed because users have logged out.
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To change the refresh interval:

1. On the Assignments tab, enter a value in the Refresh (minutes) field.

2. Click the Refresh button or click another tab to save the refresh interval.

To manually refresh data:

• Click the Refresh button at the upper right of the Assignments, Bed/Role,

or Staff tabs.

Using Staff Assignment Premier Features

This section describes end user features available with Staff Assignment Premier.

User Status Indicators

On the Assignments tab, you can quickly identify the current status of staff

members by looking at the color indicators to the left of their names. The status

colors (green, yellow, and red) are the same used by Vocera smartphone clients.

Table 4. User status indicators

Status Indicator Description

 Green The user is online and available for a call.

 Yellow The user is online but unavailable for a call. The user may
be on a call or in Do Not Disturb mode.

 Red The user is offline, either because he or she is logged off or
is currently off network.

Note: In the User Sessions dialog box, users that have
a dotted red status indicator are Staff Assignment
application users but not Vocera device users (for example,
the user may have logged into Staff Assignment using the
Administrator account).

Calling or Broadcasting from Staff Assignment

While using Staff Assignment, you can initiate a call or broadcast to a bed

group or to staff members on the Assignments tab. The call can be made from

a Vocera badge (or any Vocera device) or a desk phone. By calling directly from

Staff Assignment, you can connect quickly to other users without interacting

with the Vocera Genie, which is useful in high noise environments. In addition,

this feature allows a unit secretary, who may not have a Vocera device, to

interact with mobile staff members.
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To call or broadcast from Staff Assignment, you must be logged in as a Vocera

user. You cannot call or broadcast from Staff Assignment if you logged in as

"Administrator".

To use a desk phone instead of a Vocera device for console calls:

1. On the Assignments tab, check the Use phone for console calls box.

2. In the Ext. field, type a desk extension. You do not need to type the full 10-

digit number.

By default, the Ext. field is populated with the Desk Phone or Extension

field value from your Vocera user profile. However, you can change it to

another desk extension or even an outside number.

To call or broadcast to a bed or role from the Assignments tab:

1. Right-click a bed or role in the Bed Or Role column on the Assignments

tab, and choose one of the following calling commands:

• Call – initiates a call to the selected bed or role.

• Urgent Call – initiates an urgent call to the selected bed or role.

• Broadcast – initiates a broadcast to staff members assigned to the

selected bed or role.

• Urgent Broadcast – initiates an urgent broadcast to staff members

assigned to the selected bed or role.

Urgent calls and urgent broadcasts break through to recipients even if they

are in Do Not Disturb mode, are blocking calls, are forwarding all their calls,

or are in the middle of another call or broadcast. These commands require

urgent calling and broadcasting permissions.

2. If you place the call from a desk phone, pick up the receiver when the

phone rings, listen for your name, and then press the star key (*) to start

the call or broadcast.

Note:  When you use a desk extension to make a call from Staff Assignment,

the Vocera Genie announces the logged in user's name as a security precaution.

This deters Staff Assignment users from making calls from unauthorized phone

extensions.

To call a staff member from the Assignments tab:

1. Select a cell where a staff assignment has already been made for a bed or

role.

2. Right-click the cell, and choose one of the following calling commands:

• Call – initiates a call to the selected user.
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• Urgent Call – initiates an urgent call to the selected user.

An urgent call breaks through to recipients even if they are in Do Not

Disturb mode, are blocking calls, are forwarding all their calls, or are

in the middle of another call. This command requires urgent calling

permission.

3. If you place the call from a desk phone, pick up the receiver when the

phone rings, and then press the star key (*) to start the call.

Note:  When you use a desk extension to make a call from Staff

Assignment, the Vocera Genie announces the logged in user's name as a

security precaution. This deters Staff Assignment users from making calls

from unauthorized phone extensions.

Sending a Text Message

You can use Staff Assignment to send short text messages (up to 200

characters) to users who have been assigned to beds or roles on the

Assignments tab.

To send a text message from Staff Assignment, you must be logged in as a

Vocera user. You cannot send a text message from Staff Assignment if you

logged in as "Administrator".

To send a text message to a user from the Assignments tab:

1. Select a cell where a staff assignment has already been made for a bed or

role.

2. Right-click the cell, and choose Send Text Message. The Text Message

dialog box appears.

3. Type a text message. It can be up to 200 characters.

Note:  If any predefined text messages have been defined for your unit by

the administrator, you can select one, edit it, and then send it. For example,

if there is a predefined message "Water requested by Room," you can

select it from the list, type the room number at the end of the message, and

then click Send.

4. Click Send.
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Locking the Screen

Once you have finished making staff assignments for all units, you may want to

lock the screen temporarily to prevent inadvertent changes. You can unlock the

screen later to reassign staff or enter notes. Your session will continue to refresh

and show other people's updates, and the Refresh button is still active.

When you lock the screen, only your session is affected. While your screen

is locked, other Staff Assignment users can still log in and change staff

assignments.

To lock the Assignments tab to prevent changes:

• On the Assignments tab, make sure the Lock box is checked.
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 Setting Up and Administering the Application

The Setup tab allows you to set up the Staff Assignment application and

manage Staff Assignment user sessions. Only a Vocera user with System

Administrator permission can see the Bed/Role and Setup tabs. Other users

can only see the Assignments and Staff tabs.

The system administrator should set up the units for the application and

specify the type of authentication used. By default, only Vocera users with

System Administration permission can log into Staff Assignment. If people

without Vocera user accounts need to use the application, the system

administrator must create an application password. Otherwise, you can specify

the Administrator account and password to allow people with Vocera user

accounts to log into Staff Assignment using their Vocera user ID and password.

Staff Assignment Setup Checklist

To set up the Staff Assignment application, a Vocera system administrator must

complete the following tasks:

1. Set up system preferences, default settings for users, and groups
managed by Staff Assignment in the Vocera Administration Console.

See Best Practices for Staff Assignment on page 39.

2. Log into Staff Assignment, and set up the hospital units that will use
Staff Assignment.

See Adding or Editing a Unit on page 24.

3. Assign beds or roles to hospital units.

See Assigning Beds or Roles to Units on page 26.

4. Optionally, assign staff members and groups to each hospital unit. This
task could also be performed by Staff Assignment end users.

See Assigning Staff Members or Groups to Units on page 14.
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5. Set up Staff Assignment authentication to permit end users to log into
the application.

See Setting Up Staff Assignment Authentication on page 27.

6. Optionally, modify the Staff Assignment configuration file to change
application properties.

See Modifying the Staff Assignment Configuration
File on page 29.

7. Optionally, configure email settings in the Vocera Administration Console
to enable email alerts.

See Sending Email Alerts on page 34.

8. Make sure Staff Assignment end users configure the security level for
Internet Explorer to Medium-low or lower.

See Browser Security Requirements on page 8.

9. If you have a Vocera Server cluster, create a Staff Assignment Login page
for end users.

The page should provide links to the Staff Assignment URL for each
Vocera Server in the cluster. If one of the Vocera Servers is down, users
can click a link to log into the other server.

10. If you have Staff Assignment Premier, you may optionally assign Staff
Assignment Premier licenses to specific users or groups.

See Assigning Staff Assignment Premier Licenses to Users and
Groups on page 35.

11. If you have Staff Assignment Premier, you may need to close user
sessions to free up licenses for other users.

See Managing Staff Assignment User Sessions on page 35.

12. If you have Staff Assignment Premier, you may optionally create
predefined text messages that can be used for each unit.

See Creating Predefined Text Messages on page 37.

Adding or Editing a Unit

A unit is a hospital unit, such as Dialysis, Cardiac Intensive Care, or Surgical

Oncology, which has beds with nurses assigned to them. These units must be

defined in the Staff Assignment application, although they may also exist as

department groups in the Vocera system.

After you create a unit, you can change its description. You cannot change its

name.
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To add a new unit:

1. On the Setup tab, select a site from the Site list.

2. Click Add New Unit. The Add Unit dialog box appears.

3. Enter the name of the unit and a description; both fields can be up to 30

characters long. The name must be unique.

4. Save the unit by clicking either the Save button or the Save and Continue

button:

• Save – saves the unit and closes the Add Unit dialog box.

• Save and Continue – saves the unit, and clears the Add Unit dialog box

so that you can add another unit.

To edit a unit's description:

1. On the Setup tab, select a site from the Site list.

2. Select a unit.

3. Click Edit Unit. The Edit Unit dialog box appears.

4. Edit the unit description.

5. Click Save.

Deleting a Unit

If you created a unit with the wrong name, you cannot modify the name.

However, you can delete the unit and create another one with the correct

name.

Important:  When you delete a unit, you also delete the unit's bed and staff

data. However, staff assignments for the beds are not deleted and continue to

be maintained on the Vocera Server.

To delete a unit:

1. On the Setup tab, select a site from the Site list.

2. Select a unit.

3. Click Delete Unit.

4. You are prompted whether to delete the selected unit. Click Yes.
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Assigning Beds or Roles to Units

The Bed/Role tab allows the system administrator to select the beds and roles

that are available in each unit. A bed is any Vocera group associated with a

patient. A role is a Vocera dynamic group that contains staff members who

perform a specific role or task. For example, Charge Nurse could be a role. Only

a Vocera user with System Administration permission can see the Bed/Role tab.

Hospital beds and roles must be created in the Vocera system as groups. The

staff members that are assigned to the beds or roles during a shift are members

of the group.

You cannot use the Staff Assignment application to create beds or roles.

The system administrator creates groups for beds and roles in the Vocera

Administration Console.

Note:  Up to 200 beds or roles can be assigned to each unit.

To assign beds or roles to a unit:

1. On the Bed/Role tab, select a site from the Site list.

2. Select a unit from the Unit list.

3. To add beds or roles to the unit:

a. Select one or more beds or roles in the Groups in Site list.

To select contiguous beds in the list, press Shift+click.

To select noncontiguous beds in the list, press Ctrl+click.

To find a bed group in the site, start typing the name of a bed group

in the find text box. A drop-down list appears with names of matching

bed groups. Select one from the list.

If it is a long list, use navigation controls below the list to see the next or

previous 200 members.

b. Click the  button to move beds selected in the Groups In Site list to

the Assigned To Unit list.

4. To remove beds or roles from the unit:

a. Select one or more beds or roles in the Assigned To Unit list.

b. Click the  button to move beds selected in the Assigned To Unit list

to the Groups In Site list.
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Handling Departments and Subdepartments

On the Bed/Role tab, Staff Assignment displays an asterisk (*) next to

department names and two asterisks (**) next to subdepartment names to

help you identify those types of groups. Generally, when you assign beds or

roles to a unit, you should NOT assign department groups or subdepartment

groups since they do not represent beds or roles and they do not have dynamic

membership.

If you inadvertently select one or more department groups or subdepartment

groups in the Groups in Site list, and then click >> to assign them to the unit,

the Assign Bed/Role dialog box appears.

From the Assign Bed/Role dialog box, you can click the Depts\Subdepts tab to

see which of the groups you selected are departments or subdepartments.

Click Yes to assign all groups, including subdepartments. When a

subdepartment is assigned, its group type is changed from Subdepartment

to Ordinary. If any department groups were selected, they are automatically

excluded from the unit.

If you don't want to assign the groups, click No, and then choose other groups

to assign from the Groups in Site list.

Setting Up Staff Assignment Authentication

Users can log into Staff Assignment using one of the following authentication

options:

• Vocera username and password

• Any name and the Staff Assignment application password

• Active Directory credentials.

For users without Vocera or Active Directory credentials, create an application

password.

If you specify an application password, all users except for Vocera users with

System Administration permission must specify the application password when

they log in. Otherwise, all users must specify their Vocera password when they

log in.

The application password can be changed at any time. If you change the

application password, make sure to notify the Staff Assignment users of the

new password.

The application password certificate file is saved to and read from the \vocera

\data\applications\StaffAssignment directory on the Vocera Server.
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Note: Do not manage authentication type using the security options when

Active Directory authentication is configured. For details about configuring

Active Directory, see the Vocera Administration Guide.

To set up Staff Assignment authentication:

1. On the Setup tab, click Security. The Security dialog box appears.

2. Select the type of authentication used for Staff Assignment:

Vocera User Login Allows people with Vocera user accounts to be able
to log into Staff Assignment. This is the default
authentication type. This type of authentication is
required for Staff Assignment Premier functionality.

Application Login Allows people without System Administration
permission to log into Staff Assignment using the
application password.

Users with System Administration permission can log
into Vocera Staff Assignment using their Vocera user
ID and password instead of the application password.

3. In the Admin Name field, enter the name of the Vocera administrator

account. The default administrator account is called Administrator. This field

is required and cannot exceed 50 characters.

4. In the Admin Password, enter the administrator password. The default

administrator password is "admin". This field is required and cannot exceed

30 characters.

5. Enter the Application Password and Re-type Application Password

fields. If Application Login is selected, this field is required. It cannot

exceed 30 characters.

6. Click Save.

A message prompts that a password certificate has been created. Click OK.

7. If you specified an application password, notify all Staff Assignment users of

the new application password.
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Resetting the Administrator or Application Passwords

When you set up Staff Assignment authentication, the Vocera administrator

username and password are encrypted and saved to a certificate that is used

for Staff Assignment authentication. If the Vocera administrator subsequently

changes the administrator username or password, Staff Assignment users

without administrator privileges will be unable to log in until a new Staff

Assignment certificate is saved. Users without administrator privileges who try

to log into Staff Assignment will see the following error:

Certificate not found: Invalid certificate

To reset Staff Assignment authentication, click the Setup tab, click Security,

specify the Vocera administrator username and password, and then click Save

to save the new certificate.

If you allow non-Vocera users to log into Staff Assignment, you can also change

the Staff Assignment application password in the Security dialog box. Whenever

you change the application password, make sure to notify the Staff Assignment

users of the new password.

Modifying the Staff Assignment Configuration File

After the Vocera Server is installed and the Tomcat service is started, the Staff

Assignment application automatically generates a configuration file on the

server. You can edit the configuration file to configure the application. The file is

named app.config and it is located in the following folder:

\vocera\data\applications\staffassignment

The app.config file is NOT synchronized continuously with Vocera cluster

nodes, unlike Vocera Server database transactions. However, the file is saved

along with the Vocera Server data during a scheduled or manual backup, and it

is automatically copied from the active Vocera node to standby nodes during a

remote restore.

Configuration of Staff Assignment is optional. The default configuration may

work fine for you. You can edit the file in any text editor, such as Notepad.

Note:  Property names in the app.config file are case-sensitive.
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The following table describes the Staff Assignment application properties in

alphabetical order (they may appear in a different order in the app.config file):

Table 5. Staff Assignment application properties

Property Description

appDescription Descriptive text for the Staff Assignment application,
which appears at the top of the Staff Assignment
page. The default is Staff Assignment Premier or Staff
Assignment, depending on your license.

checkBedRoleType Sets whether to check whether Bed/Role groups
that are assigned to a unit are "Subdepartments,"
and if so to change them automatically to
"Ordinary" groups. Enter 1 (Yes) or 0 (No).
The default is 1. For more details on how
Staff Assignment handles departments and
subdepartments, see Handling Departments and
Subdepartments on page 27.

checkDB(hrs) Hours between Staff Assignment database validation.
Staff Assignment database Staff and Group names
are compared with the Vocera Server database.
Invalid Staff Assignment database entries are
removed. The default is 4, meaning the Staff
Assignment database is validated every 4 hours.

Note: If you modify this property, you must restart
the Tomcat service to load the new value.

columnCount The number of staff columns for each bed or role.
Enter an integer from 2 to 8. The default is 4.

columnNames A comma-separate list of up to 8 column names for
the Assignments tab. The default list is "1st Member,
2nd Member, 3rd Member, 4th Member, 5th
Member, 6th Member, 7th Member, 8th Member".

Note: For optimal display, try to limit column names
to 15 characters or less.

logMsgs Sets whether to log Staff Assignment activity
(including logins, errors, assignments) to the \vocera
\logs\staffassignment folder on the Vocera Server.
Enter 0 (no logging) or 1 (logging enabled). The
default is 1.
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Property Description

maxLogFiles Maximum number of log files. The default is 100,
and the maximum is 5000.

Note: If you modify this property, you must restart
the Tomcat service to load the new value.

maxLogLines Maximum lines of activity per log file. The default is
50000.

Note: If you modify this property, you must restart
the Tomcat service to load the new value.

maxNotesSize Maximum number of characters per notes entry. The
default is 500.

maxUnitGroups Maximum Bed/Roles that can be assigned to a Unit.
The default is 200.

maxUnitUsers Maximum Staff Users and Staff Groups that can be
assigned to a Unit. The default is 200.

serverIP Comma-separated list of Vocera Server cluster IP
addresses, in dotted-decimal notation. On each
standby Vocera Server, this property must be updated
manually. On the active Vocera Server, this property
is automatically updated when a user logs into Staff
Assignment.

If you have a standalone Vocera Server, enter its IP
address.
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Property Description

serverIPalias Comma-separated list of Vocera Server cluster IP
address mappings, in dotted-decimal notation. You
should only use this property if you have a Vocera
Server cluster and your Vocera Server computers have
dual NIC cards, one for a "private" IP address and
one for a "public" IP address.

For each IP address mapping, separate the private IP
address from the public address with a ">" character.
For example, if 10.98.2.101 and 10.98.2.102 are the
private IP addresses and 101.0.0.1 and 101.0.0.2
are the public IP addresses, you would enter the
following value for the serverIPalias property:

serverIPalias =
10.98.2.101>101.0.0.1,
10.98.2.102>101.0.0.2

If you need to enter values in the serverIPalias
property, make sure you enter the private IP
addresses for Vocera Server cluster nodes in the
serverIP property.

sitePermissions Sets whether users who log into Staff Assignment
can view and edit units at all sites or only units at
their site. Enter "allSites" (the default) or "userSite".
Users with system administration permission can
always view and edit units from all sites.

Note:  You may also see staffPrimary and staffSecondary properties in the

app.config file, but those properties are obsolete and have been replaced by

the columnNames and columnCount properties.

To edit the Staff Assignment configuration file:

1. On the Staff Assignment computer, open the following file in a text editor:

\vocera\data\applications\staffassignment\app.config

2. Edit any of the properties.

3. Save your changes.

4. If you changed any of the following properties, stop and start the Tomcat

service:

• checkDB(hrs)

• maxLogLines

• maxLogFiles
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Changes to other Staff Assignment application properties do not require

you to restart Tomcat. They take effect the next time someone logs into the

Staff Assignment application.

5. If you have a Vocera cluster, copy the app.config file to every Vocera Server

node.

To reset the Staff Assignment configuration file to default settings:

1. On the Staff Assignment computer, open the following folder:

\vocera\data\applications\staffassignment

2. Rename the app.config file to app.config.old.

3. Open an Internet Explorer browser window, and log into Staff Assignment.

A new app.config file is generated on the server with default settings.

4. If necessary, open the new app.config file in a text editor, make changes to

the file, and then save your changes.

5. If you have a Vocera cluster, copy the new app.config file to every Vocera

Server node.

Enabling or Disabling Staff Assignment Logging

You can enable or disable logging of Staff Assignment activity by setting the

logMsgs property in the app.config file on the server. The application logs any

logins, errors, and assignments. Logging is enabled by default.

When logging is enabled, log files are saved to the following folder on the

Vocera Server:

\vocera\logs\staffassignment

To enable or disable Staff Assignment logging:

1. On the Staff Assignment computer, open the following file in a text editor:

\vocera\data\applications\staffassignment\app.config

2. Change the value of the logMsgs property.

• To enable logging, set logMsgs to 1.

• To disable logging, set logMsgs to 0.

3. Save your changes.

Note:  You do not need to restart Tomcat.

4. If you have a Vocera cluster, copy the app.config file to every Vocera Server

node.
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Backing Up and Restoring Staff Assignment Data

The Staff Assignment application data and certificate file are stored in the

\vocera\data\applications\StaffAssignment directory on each Vocera Server

node in a cluster, and the data is synchronized between the cluster nodes.

When the Vocera Server creates a scheduled backup file or the Vocera Server

administrator creates a backup file manually using the Administration Console,

the Staff Assignment application data and certificate file are also saved to the

backup file.

The Staff Assignment configuration file (app.config) is also saved to the

backup file when you back up Vocera Server data. The configuration file is NOT

synchronized between cluster nodes, but it is automatically copied to cluster

nodes during a remote restore.

If you restore Vocera Server data from a backup file, the Staff Assignment

application data, certificate file, and configuration file contained within the

backup file are also restored.

For more information about restoring data from a backup file, see the Vocera

Administration Guide.

Sending Email Alerts

Staff Assignment uses the Vocera Server email alert feature to automatically

send an alert message to the Vocera system administrator whenever the

application changes a department or subdepartment group to an ordinary

group. This can happen in two ways:

• Someone changed a bed/role group to a department group or

subdepartment group, either using the Administration Console or by

upgrading the Vocera Server. When Staff Assignment performs a refresh of

data from the Vocera Server, the bed/role group is automatically reverted to

an ordinary group.

• A Staff Assignment user with System Administrator privileges has added

a subdepartment group to a unit and thereby converted it to an ordinary

group.

These alerts are for information purposes only. Corrective action may not be

necessary.

Note:  Staff Assignment alerts are enabled only if the Vocera system

administrator has configured email settings in the Administration Console. For

more information, see the Vocera Administration Guide.
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Assigning Staff Assignment Premier Licenses to Users and Groups

If your organization has purchased a select number of Staff Assignment Premier

licenses, the Vocera system administrator can assign those licenses to specific

users and groups. This ensures that users who have been assigned a Staff

Assignment Premier license will always have access to extended functionality

when they log in. Users who have not been assigned a Staff Assignment

Premier license will automatically log in with the Staff Assignment Standard

license.

You can assign Staff Assignment Premier licenses to a group that has more

members than there are available licenses. When all Staff Assignment Premier

licenses are in use, users who subsequently log in will automatically get the

Staff Assignment Standard license.

To assign a Staff Assignment Premier license to a user or group:

1. On the Setup tab, click Licenses. The Premier Licenses dialog box appears.

2. In the Find User/Group field, start typing the last name of a user or the

name of a group. A list of matching users or groups appears.

3. Click a user or group. The Add To Premier Licenses dialog box appears.

4. Click Yes to add the user or group to the list.

5. Click Close to close the Premier Licenses dialog box.

To remove a Staff Assignment Premier license from a user or group:

1. On the Setup tab, click Licenses. The Premier Licenses dialog box appears.

2. Select a user or group in the list, and then click Delete.

Note:  Removing the Staff Assignment Premier license from users and

groups does not affect sessions in progress. However, you can close sessions

to force users to log in again.

3. Click Close to close the Premier Licenses dialog box.

Managing Staff Assignment User Sessions

Staff Assignment is a Web application, allowing multiple users to log in and

make staff assignments for your Vocera system. Administrators can log into

Staff Assignment to manage the sessions of users who have logged in. For

example, if any users have incorrectly left their session open after their shift has

ended, the administrator can close the sessions to allow other users to log in

and use the application license.
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When all of your organization's Staff Assignment Premier client licenses are

currently being used, users can still log into Staff Assignment but they won't

have access to Staff Assignment Premier features (see Using Staff Assignment

Premier Features on page 19). However, users with System Administration

permission who log into Staff Assignment with their Vocera username and

password rather than logging in as "Administrator" always have access to Staff

Assignment Premier features—including session management.

Note:  This feature is available only in Staff Assignment Premier.

To manage Staff Assignment user sessions:

1. On the Setup tab, click User Sessions. The User Sessions dialog box

appears.

The User Sessions dialog box has the following columns:

• Name – the name of the user.

• Badge Status – whether the user is logged in, logged out, in Do Not

Disturb mode, or is not a Vocera badge user.

• IP Address – the IP address of the computer running the user session.

• Since – the date and time on which the session started.

• Duration – the duration (in days, hours, and minutes) of the session.

• License – whether the session is licensed to use Staff Assignment Premier

or not.

2. To select a user session, check the box to the left of the session.

3. After one or more user sessions is selected, click one of the following

buttons:

• Console Message – sends a console text message to users running other

Staff Assignment sessions. Console messages can be used to alert console

users before closing their sessions. Recipients of console messages will see

the message the next time the application refreshes with data from the

server. A console message is limited to 100 characters.

Note:  There is no auditing trail for console messages currently, and

therefore no ability to report on when they were sent or received.

• Details – displays details of a selected session.

• Close Session – closes selected sessions. Users will be notified that their

session has been closed after any action that refreshes the application

screen.
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• Refresh – refreshes the User Sessions dialog box with latest session

information from the server.

4. When you are finished managing sessions, click Close.

Creating Predefined Text Messages

When you set up units in Staff Assignment, you may optionally create

predefined text messages that can be used for each unit. Staff Assignment

users can choose to send any text message they want within the 200-character

limit, but predefined messages may be convenient for messages that are used

commonly in a unit.

Note:  This feature is available only in Staff Assignment Premier.

To create predefined text messages for a unit:

1. On the Setup tab, click Set Text Messages. The Edit Predefined Text

Messages dialog box appears.

2. In the Site list, select a site.

3. In the Unit list, select a unit.

4. To add a new message, type a message in the text box, and then click Add.

The message can be up to 200 characters.

5. To update an existing message, select a message in the list, edit the

message in the text box, and then click Update Msg.

6. To delete an existing message, select a message in the list, and then click

Delete.

7. When you are finished, click Save All to save the messages and close the

Edit Predefined Text Messages dialog box.

8. A confirmation dialog box appears. Click OK.

Emptying the Application Database

When you use the Staff Assignment application, it saves its data on the Vocera

Server in its own data file. When you first set up the application, you may want

to create several temporary units and add some nurses to them. When you are

ready to set up actual units, you can clear the application database.

The application database file is stored in the \vocera\data\applications

\StaffAssignment directory on the Vocera Server.

Note:  Clearing the application database does not affect groups and their

members in the Vocera database.
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To clear the application database:

1. On the Setup tab, click Clear DB.

2. When you are prompted whether to clear the application database, click

Yes.
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 Best Practices for Staff Assignment

This chapter provides best practices you should follow when you set up your

Vocera system for Staff Assignment.

System Preferences and Defaults

When you configure your Vocera system for Staff Assignment, follow these best

practices:

• Make sure the Announce Name of Called Group default setting is checked

in the Administration Console (Defaults > Genie Settings).

• Make sure the Auto Logout When Badge in Charger default setting is

checked in the Administration Console (Defaults > Notification). Override

user settings to ensure the feature is enabled for everyone.

• Make sure the Enable Auto-Logout Period preference is checked in the

Administration Console (System > Preferences), and specify the time

interval at which automatic logout should occur when a device is off network

(the default is 1 hour).

Bed/Room Groups and Role-Based Groups

When you set up groups that are managed by Staff Assignment, follow these

best practices:

• Staff Assignment is designed to manage assignments to bed/room groups

and role-based groups, not to department or subdepartment groups.

Therefore, the Group Type property for all groups managed by Staff

Assignment should be Ordinary, not Department or Subdepartment.

• Groups managed by Staff Assignment can safely be nested within

department groups or subdepartment groups, as shown in the following

figure. Changes to the membership of ordinary groups do not affect server

performance.
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Figure 1. Different types of groups

• If users are used to calling a room by saying, "Call Room number," make sure

the group name for the room starts with the word "Room" (for example,

"Room 2013").

• Make sure groups managed by Staff Assignment have temporary

membership (check the Remove Users on Logout box on the Member tab

of the group).

• Make sure groups managed by Staff Assignment use sequential scheduling

(select the Sequential scheduling option on the Info tab of the group). This

ensures that calls are routed first to the first member and then to the second

member.

• If there are multiple beds per room, follow the room number by a letter (for

example, "Room 2013 A"). Leave a space between the room number and

the letter.

• Assign a virtual extension or a DID number to each bed/room group in the

Vocera Extension field on the Info tab of the group.

• Outside callers who dial the Vocera hunt number can connect to the group

by entering the group's Vocera Extension at the Genie prompt.

• The Vocera Extension can be used as the device ID for Alerts and Alarms

in your middleware system.

• Use the following convention for extensions: Extension = Room Number +

Bed Number + Role Number
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• Bed Number: 0=private room, 1=Bed A, 2=Bed B

• Role Number: 1=RN, 2=RN Secondary, 3=CNA, 4=Tech

• You can use the Update page of the Vocera Administration Console to

update groups managed by Staff Assignment, ensuring that they conform to

best practices. You typically export existing groups to a CSV file, edit the CSV

file, and then use the update feature to copy data from the CSV file back to

the Vocera database.

For more information about updating groups, see the Vocera Administration

Guide.
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 Frequently Asked Questions

This section provides answers to frequently asked questions about using and

setting up Staff Assignment.

Questions about Using Staff Assignment

These questions deal with how to use Staff Assignment.

Q: Can I use a browser other than Internet Explorer?

A: Vocera has certified Staff Assignment running only on Internet Explorer 6,

7, or 8. Other browsers have not been tested.

Q: Can I login to Staff Assignment using my Active Directory

credentials?

A: Yes. As of release 4.4, you can use Active Directory credentials to login

into Staff Assignment. This option must be enabled by the Vocera System

Administrator. For more information, see Active Directory Login
1
.

Q: How many staff members can I assign to each bed?

A: You can assign up to 8 staff members to each bed or role, although by

default only 2 staff member columns are available.

Q: Can someone be assigned to multiple beds?

A: Yes. This is a common scenario. However, a staff member cannot be

assigned multiple times to the same bed.

Q: Can I assign someone from another site to a bed?

A: Yes. On the Assignments tab, use the Find Staff field to find a staff

member at another site. The Add To Unit dialog box appears, allowing

you to add the staff member to the unit and to the selected bed.

Q: How can I tell if staff members are logged in and available for a

call?

1
 staffassignment_aboutAD.xml#staffassignment_aboutAD

staffassignment_aboutAD.xml#staffassignment_aboutAD
staffassignment_aboutAD.xml#staffassignment_aboutAD
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A: If you have Staff Assignment Premier, colored status indicators (green for

online, yellow for online but unavailable, and red for offline) appear to the

left of each cell on the Assignments tab.

Q: When is a staff assignment saved to the Vocera Server?

A: After you select a staff member for a field, press Enter or click another cell

to save the assignment. The status bar at the bottom of the Assignments

tab indicates when staff are added or removed.

Q: What should I enter in the Notes field on the Assignments tab?

A: Add any helpful information about the assignment. Here are some

examples:

• DNR

• Clear Liquid Diet

• No visitors

• Maintain Reverse Isolation

• Marie in charge from 7 – 12 Noon and Christine in charge from 12

Noon – 4 PM

Note:  To preserve patient privacy, avoid using patient names in the

Notes field.

Q: Can users still add themselves to groups using voice commands on

the badge?

A: Yes. Users can still add themselves to groups using voice commands,

and these assignments can be further managed using Staff Assignment.

However, if your site is implementing Staff Assignment, as a best

practice Vocera recommends using Staff Assignment to perform all staff

assignments. You may need to retrain Vocera users to not use voice

commands to add themselves to groups.

Q: Does Staff Assignment have record locking?

A: Yes. If someone else has posted a change to a bed group assignment

after you began editing a field, you won't be allowed to post an update

to the field because it is currently "dirty." Staff Assignment will display

an error message telling you that the bed group has been updated. The

application will then fetch the latest data from the server.

Q: I finished assigning staff members to beds and roles for all units.

Can I lock the screen to prevent changes?
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A: If you have Staff Assignment Premier, you can lock the screen by checking

the Lock checkbox on the Assignments tab. When you lock the screen,

only your session is affected. While your screen is locked, other Staff

Assignment users can still log in and change staff assignments.

Questions about Setting Up Staff Assignment

These questions deal with setting up Staff Assignment.

Q: How can I change the number of staff member columns for each

bed or role?

A: By default, Staff Assignment displays 4 staff member columns, but the

application supports up to 8. To change the number of staff member

columns, edit the value of the columnCount property in the app.config

file. To change the column names, edit the value of the columnNames

property. See Modifying the Staff Assignment Configuration

File on page 29.

Q: Does Staff Assignment support using encrypted access using SSL?

A: Yes. Like the Administration Console and the User Console, Staff

Assignment supports using encrypted access to the server. You can

optionally enable SSL access in Vocera web clients during installation of

the Vocera Server. At any time after installation of the Vocera Server, you

can enable or disable SSL access as described in the Vocera Administration

Guide.

Q: Can users who have a Vocera ID but do not have a Vocera

password log into Staff Assignment?

A: Yes, if you create an application password that users can use to log in. See

Setting Up Staff Assignment Authentication on page 27. Otherwise,

your Vocera users must have a password to log into Staff Assignment.

You cannot log into Staff Assignment using a blank password.

To use Staff Assignment Premier features, users must log into Staff

Assignment with their Vocera user ID and password.

Q: How can I allow people without Vocera user accounts to use Staff

Assignment?

A: In the Setup tab, click Security to create an application password. See

Setting Up Staff Assignment Authentication on page 27.

Q: I changed the Vocera administrator password and now Staff

Assignment users cannot log in. Why?
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A: The Staff Assignment application requires a Vocera administrator login

to connect to the Vocera server. When you set up Staff Assignment

authentication, the Vocera administrator username and password are

encrypted and saved to a certificate that is used for Staff Assignment

authentication. If the Vocera administrator changes the administrator

username or password, Staff Assignment users without administrator

privileges will be unable to log in until a new Staff Assignment

certificate is saved. See Resetting the Administrator or Application

Passwords on page 29.

Q: How can I remove staff assignments from beds automatically when

a shift change occurs?

A: In the Vocera Administration Console, configure the group to

automatically remove users from membership in the group when they log

out. Edit the group to open the Edit Group dialog box, and then click the

Member tab. Make sure the Remove Users On Logout box is checked.

When users log out at the end of their shifts, they will be logged out from

all bed groups with temporary membership (that is, groups that have the

Remove Users On Logout box checked).

Q: You can assign staff members to beds and roles. What is a role?

A: A role is a Vocera dynamic group that contains staff members who

perform a specific role or task during a hospital shift. For example, Charge

Nurse could be defined as a role-based group in Vocera. If your Vocera

system has role-based groups, users can use Staff Assignment to assign

staff members to roles as well as beds.

Q: When you define bed/room groups or role-based groups, can you

put them inside department groups?

A: Yes. Bed/room groups and role-based groups do not affect the

department grammars, so you can safely put them within departments.

Q: When you clear the Staff Assignment database, what information

is lost?

A: All staff assignments are stored on the Vocera Server; clearing the Staff

Assignment database does not affect those assignments. However, units

are not stored in the Vocera database, so they are lost if you clear the

Staff Assignment database.

You should not need to clear the Staff Assignment database unless you

have created temporary units to test the application and when testing is

finished you want to start over fresh. It takes only a few minutes to create

new units, assign available staff to the units, and assign beds to the units.
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When you clear the Staff Assignment database, the following information

is lost and must be recreated.

• Units

• Staff members assigned to units (staff-unit associations)

• Beds assigned to units (bed-unit associations)

• Notes for assignments

Q: How do you back up and restore Staff Assignment application

data?

A: The Staff Assignment application data, certificate file, and configuration

properties are saved along with the Vocera Server data during a

scheduled or manual backup. To restore the Staff Assignment application

data, certificate file, and configuration properties, use the Vocera

Administration Console to restore data from a backup file.

Q: Under what situations does Staff Assignment send an email alert

to the Vocera system administrator?

A: Staff Assignment uses the Vocera Server email alert feature to

automatically send alert messages to the Vocera system administrator

whenever the application changes a department or subdepartment group

to an ordinary group. For details, see Sending Email Alerts on page 34.

Q: Where can I see the number of Staff Assignment Premier licenses

currently in use?

A: On the Setup tab, click User Sessions. See Managing Staff

Assignment User Sessions on page 35.
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 Staff Assignment Quick Reference

Log In

1. Open Internet Explorer and type in the following URL:

http://vocera_ip_address/staffassignment

where vocera_ip_address is the numeric IP address of
the Vocera Server.

2. Enter your Staff Assignment user name and password, and
then click Login.

Assign a Staff Member to a Bed or Role

1. On the Assignments tab, select a site from the Site list.

2. Select a unit from the Unit list.

3. Optionally, enter notes about the assignment in the Notes
field.

4. Select one of the staff member cells for a bed or role. Start
typing the last name of a staff member. A drop-down list
appears with up to 10 matching names. Select a staff member
from the list.

Find a Staff Member

1. On the Assignments tab, click the Find Staff box.

2. Start typing the last name of a staff member. A drop-down list
appears with up to 10 matching names.

3. Select a staff member from the list.

Note: If the Lock checkbox is checked, the Find Staff box is not
visible.
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Remove an Assignment

1. Select the cell and press the Delete key.

2. Press Enter.

Lock the Screen

On the Assignments tab, check the Lock box.

Note: This feature is available only in Staff Assignment Premier.

Call or Broadcast

1. If you prefer to call from a desk phone, select the
Assignments tab, check the Use phone for console calls
box, and then type an extension in the Ext field.

2. On the Assignments tab, right-click either a bed or role or a
cell where a staff assignment has been made.

3. Select one of the following commands from the pop-up menu:

Bed or Role Commands Staff Member Commands

Call
Urgent Call*
Broadcast
Urgent Broadcast*

Call
Urgent Call*

* Urgent calls and broadcasts require special permission.

4. If you are using a desk phone, pick up the receiver when the
phone rings, press the star key (*), and begin speaking.

Note:  This feature is available only in Staff Assignment Premier.

Send a Text Message

1. On the Assignments tab, right-click either a bed or role or a
cell where a staff assignment has been made.

2. Select the Send Text Message command from the pop-up
menu.

3. The Text Message dialog appears. Type the message (up to 200
characters), and click Send.

Note: This feature is available only in Staff Assignment Premier.
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Print a Page

1. Click the Print link at the upper right part of the page.

2. Select print options, and then click Print.

DO NOT use the Print toolbar button or the File > Print command
in Internet Explorer. Those print options do not print the entire
table.

Use Voice Commands

You can call the nurse assigned to a bed or room using your Vocera
device.

To call a nurse for Room 5423 Nurse, say this:

Call Room 5423 Nurse

To find who is assigned to Room 5423 Nurse, say this:

Who is in Room 5423 Nurse?

Who is a member of Room 5423 Nurse?
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 Index

A
Active Directory, 12
Add To Unit dialog box, 15, 17
administration, 23
alerts (see email alerts)
app.config file, 29
assigning beds or roles to units, 26
assigning Staff Assignment Premier licenses, 35
Assignments tab, 15

status indicators, 19
tips, 17

authentication, 27

B
backing up data, 34, 47
Bed/Role tab, 26
best practices, 39
browser requirements, 7

security, 8

C
calling, 19
clearing the application database, 37, 46
click-to-connect, 19
cluster

connecting to a, 13
configuration file, 29

D
dirty record, 44

E
email alerts, 34, 47
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emptying the application database, 37, 46

F
finding a staff member, 15
Found In Unit dialog box, 15, 17
frequently asked questions, 43

I
Internet Explorer requirements, 7

security, 8
introduction, 7

L
licenses, Staff Assignment Premier, 35
list navigation controls, 15
locking the screen, 22
logging in and out, 11
logging, enabling and disabling, 33

N
Notes field, 44

P
password, application, 27
printing, 18
properties, application, 29

Q
quick reference, 49

R
record locking, 44
refreshing data, 18
restoring data, 34, 47
roles, 26, 46

S
security, browser, 8
Setup tab, 23
Staff tab, 14
status indicators, users, 19
system preferences and defaults, 39

T
text messages

predefined, 37
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sending, 21

U
unit

adding, 24
deleting, 25
editing, 25

urgent calling, 19
user sessions, 35
user status, 19

V
voice commands, 44
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